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Overview 
This document contains the workflows necessary for producing a set of plans for 
pavement preservation projects, including the title sheet, notes sheets, summary 
sheets, and typical sections. This document also covers how to create and plot a sheet 
set. 

Process Provenance 

• Date of development: 3/21/2023 

• Revision date: 8/29/2023 

• Application/Tool(s): Autodesk Civil 3D 

• Version(s): 13.4.2162.0 Civil 3D 2022.2.2 

• Environment(s): MDT Civil 3D State Kit r2022 v1.22 

• Author: MDT Road Design Workflow Subcommittee 

 

Statement of Need 
Pavement preservation plans do not require civil objects and thus were not covered in 
Civil 3D production training. Therefore, separate workflows were necessary to outline 
the process for creating plans for pavement preservation processes. 

Disclaimer: One procedure in this document currently relies on Microstation for the 
county maps on the title sheet and is only intended as an interim workflow until a more 
efficient process using Civil 3D has been vetted for the maps. This document will be 
updated when the vetting and testing is complete. The update will be announced 
through the same channels that this workflow was announced. 

Acronyms/Definitions Used in This Document 
OLE – Object Linking and Embedding. OLEs are embedded copies of information from 
another document. 

QMG – Excel Quantity Manager file 

References 
Title and Notes Sheets in Autodesk 

Summary Sheets in Autodesk 

Tips for Summary Sheets in Autodesk 

mailto:cmurphy@mt.gov;%20rbarbula@mt.gov
https://www.mdt.mt.gov/other/webdata/external/ESDC/library/Ttl-NotesShtsInAdesk.pdf
https://www.mdt.mt.gov/other/webdata/external/ESDC/library/SumSheetsInAdesk.pdf
https://www.mdt.mt.gov/other/webdata/external/ESDC/library/TipsForSumSheetsInAdesk.pdf
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203 – Civil 3D Plan Production Training 

Surfacing Calculation Spreadsheet 

https://www.mdt.mt.gov/other/webdata/external/cadd/designcalc/Surfacing.xltm
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Process Description and Examples 
Section I. Title Sheet 

Procedure – File Setup 

1. Create a new file using the design-start.dwt template. Save it as 
[UPN#]RDTTL001.dwg (for example, 9422000RDTTL001.dwg) in the RD 
directory of the project on BIM 360. Use CTRL+S or navigate to the C3D icon in 
the top left and save the file. 
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2. Create a new layout using the Road Layouts within the MDT Sheets tab of the 
MDT Tool Palette. 

 

3. Select the RD-Title layout.  

 
 Back to top 
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Procedure – Title Block 

1. Select or highlight the title block, right click and select Edit Block in-place… to 
edit the title block. 

 
  

2. In the Reference Edit menu, click OK. 
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3. The following warning dialog box will pop up. Click OK.

 
  

4. Double click any of the text fields within the Title Block to change their attributes. 
When finished with the edits, select Save Changes within the Layout Tools 
contextual tab in the ribbon to close the block editor. If prompted to save the text 
changes, accept the prompt to save and close.

 
 

NOTE: Wait to edit the sheet border project information on all the sheets until the 
sheet set has been created for the project. When created, follow the steps 
covered in Section V of this document.  

 Back to top 
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Procedure – Project Location 

1. Explode the "THIS PROJECT" callout once by typing X, or Explode, or by 
selecting the icon that looks like a cube in the Modify panel of the Home tab.  

 

 
  

2. Use the grip on the tip of the arrowhead to move the arrow to the project location.

 
Back to top 
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Procedure – Project Design Data Blocks 

1. Double click within the Project Design Data table to open the Enhanced 
Attributes Editor dialog box to edit each field. When done, click OK to save and 
exit the menu. 

 
 

2. Repeat the process above to edit the Associated Project Agreement Numbers 
and Related Projects tables, if applicable. 
Back to top 
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Procedure – Engineer’s Stamp Block 

1. Click or highlight the Engineers Stamp Block and then use the visibility state 
dropdown arrow in the center of the block to change the format to the required 
department/engineer.  
 
For example, to change the default block to Traffic & Safety, select the 
dropdown, then hover over the MDT ENGINEERING sub-menu and select 
TRAFFIC SAFETY. The block will update automatically. 

 
Back to top 
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Procedure – County Map 

1. Download the county map corresponding to the project from the County Maps 
page under Resources on the Road Design page of the MDT Intranet. Save this 
file to your C:\dgn folder. 

  
2. Open the file in Microstation. Delete unwanted objects. 

  
3. Export this file as an Autodesk DWG file by navigating to the File tab, and select 

Export -> DGN, DWG, DXF. 
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3. In the save menu, change the file type to a DWG file. Save this to your C:\dgn 
folder. 

 
 

4. Return to Civil 3D. Using the C3D icon in the top left corner, open the exported 
county map file from the previous step. 

  
5. In the county map file, highlight the linework desired to be shown in the title sheet 

and copy using CTRL+C. Navigate to the title sheet file and paste the linework 
into the model space using CTRL+V.  
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6. Create a viewport to display the county map. Set the active layer to GS-VPRT. 
Select the RD-Title Layout, then in the Layout contextual tab in the ribbon, 
select Rectangular in the Layout Viewports. Specify the limits of the viewport 
in the paper space by clicking upper left and lower right corners of the rectangle 
as the extents.
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7. Double click within the viewport to enter model space. Use Pan and Zoom to 

capture the area of the county map. Adjust the limits of the viewport by clicking 
and dragging the corner grips. Once the limits and scale are set, lock the 
viewport by clicking the lock icon in the status bar on the bottom right of the 
screen. 

 
Back to top 
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Procedure – RP Limits and Project Location Label 

1. Explode the C-ProjectLocationLabel block to edit its contents. 

 
 

2. Use the grips and the Move, Extend, and Trim commands to adjust the project 
limits lines and labels to match the extents of the project on the county map. To 
edit the text fields, double click within them, type the appropriate text, and press 
Esc to exit after edits are complete. 
 

3. Once the limits and labels are set, select them and type the command 
CHSPACE. Then hit Enter. This will swap all highlighted linework from the paper 
space to its corresponding location in the model space. To make further edits to 
the RP Limit or Project Location information, use the model space tab and edit 
the information there. 

  
NOTE: MDT Right-Of-Way requested that Road Design place the RP Limit and 
Project Location information in the model space so that they can reference the 
model space into their drawings and make their appropriate edits.  
Back to top 
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Example of Completed Title Sheet  
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Section II. Notes Sheets 

Procedure – File Setup 

1. In the Title sheet file, create a new layout using the Road Layouts within the 
MDT Sheets tab of the MDT Tool Palette. 

 
 

2. While holding Ctrl, select either the RD-Notes-Rural or RD-Notes-Urban and 
the RD-Notes-Misc layouts based on the scope of the project. Then select OK. 
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3. Explode blocks in the RD-Notes-Rural or RD-Notes-Urban layouts and edit as 
necessary.  

 
NOTE: Additional notes not found on the sheet can be found in the RD-
Notes.dwg block library. 
 

4. If applicable, add approach tables and wetland delineation tables to the RD-
Notes-Misc layout, following the same methods outlined in the Summary Frames 
section of this document. 
 
Back to top 
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Section III. Typical Sections 

Procedure – File Setup 

1. Create a new file called [UPN#]RDTYP001.dwg using the design-start.dwt 
template. Set the drawing scale to 1" = 10' and set the working folder and data 
shortcuts appropriately. 

NOTE: In future versions of the State Kit, a Typical Sections template file will be 
created with the view frames already built into them. In the meantime, follow the 
File Setup and Border Setup procedures. 

2. Create a new layout using the Road Layouts within the MDT Sheets tab of the 
MDT Tool Palette. 
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3. Select the RD-Typical layout. 

 
 

4. Select the newly added RD-Typical layout tab. 
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5. Select the border of the sheet and select the block visibility state dropdown arrow 
in the lower right corner of the border. Change the designation from No Split to 
Split Horizontal to divide the border in half for typical sections. 

  Back to top  
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Procedure – Border Setup 

1. While in the RD-Typical layout, type the command VPORTS. Accept the 
defaults and select OK. 

 
 

2. You will be prompted to specify the corners of the viewports. Select the corners 
of the border sheet as shown below: 
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3. Return to the paper space by double clicking outside the extents of the viewport 
border. In the paper space, select the viewport border (turn on Selection Cycling 
[Command: SELECTIONCYCLING, variable 2] to aid in selecting) and use the 
Properties palette set the both the Annotation Scale and the Standard Scale 
of the viewport to 1"=10'.  

 Selection Cycling icon on bottom bar: 

 
 
Viewport settings: 
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4. In the paper space, draw a rectangle around the viewport either using the 
RECTANG command or selecting the rectangle tool from the Drawing tools in 
the Home ribbon tab. Draw a horizontal line (Command: L for line or PL for 
polyline) on top of the Split Horizontal border line. Ensure your snaps are on so 
that the line snaps to the midpoint of the vertical line of the rectangle. Then select 
the rectangle and line and type CHSPACE to put them into the model space. 

 
 

5. Return to the model space via the Model tab and find the border using Zoom 
Extents. 

  



Montana Department of Transportation - Plans Production for Pavement 
Preservation Projects in Autodesk 

 

Typical Sections PAGE 26 | 65 
 

6. In the model space, open the blocks palette by typing BLOCKSPALETTE or by 
going into the Insert tab and selecting the Insert dropdown of the Block section 
and selecting Blocks from Libraries. 

 
 

7. In the Blocks palette, select the Libraries tab and double click the RD-
Typicals.dwg library. 
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8. Within the library, select the T-TablesQtyStaLabel block so that it is attached to 
the cursor and ready to be inserted into the drawing. Using the midpoint snap, 
select the midpoint of the upper horizontal line of the border as the insertion 
point.  

 
 

9. Repeat the process above for the second typical section, except snap to the 
midpoint of the split horizontal line. 
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10. Select the border lines and blocks and copy the shapes diagonally until you have 
as many typical borders as you need sheets.  
 
NOTE: Copying diagonally ensures that no more than two section view frames 
overlap. Overlapping section views can cause issues when adjusting dimensions 
on the typical sections, which arise when the view frame needs to be adjusted 
vertically to better position the section view within the sheet border. 
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An example setup for five to six typical sections:

 
 

11. Delete the default Layout1 from the drawing to clear up space by right clicking 
the layout and selecting Delete. 
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12. Copy Layouts: Copy the RD-Typical layout to create more layout sheets. Right 
click the RD-Typical Layout and select Move or Copy… from the list. 

 
 

13. In the Move or Copy dialog, select (move to end), and check the Create a 
copy box. Then select OK. 
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14. In the copied layout RD-Typical (2), double click within the viewport and type 
OSNAPCOORD and change the variable to 0. 
NOTE: This step only needs to be completed once; however, if you update the 
State Kit, you will need to reset the variable. 

15. While in the viewport, select the dropdown next to Extents from within the 
Navigate 2D panel in the View tab and select Window. You can also type the 
command ZOOM and type or select W for window. 
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16. With endpoint snaps turned on, select the upper left and lower right corners of 
the rectangle border. 
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17. Double click outside of the viewport to return to paper space.

 

 
18. Repeat Steps 12 through 16 as necessary. 
19. Once complete, lock the viewports in each layout to avoid any accidental 

changing of the viewport scale while switching between the model and paper 
space. Select the viewport then select the viewport lock button in the Quick 
Access toolbar on the bottom of the screen.
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20. In the model space, select the title blocks and explode them by typing X then 
hitting Enter. 

NOTE: Explode the Typical Section title and the Mainline subtitle to a single line 
text box after exploding the block to have it display in paper space. This issue 
will be fixed in a future version of the State Kit, which pertains to the annotative 
state being turned on for the font when it is not needed. 

 
 

21. Double click within the text boxes to edit the text or the tables. If you need to add 
a new line to the station ranges, select a row of the table, right click, and select 
Insert Row Below or select it from the contextual tab for the table in the ribbon. 

 
NOTE: A macro for calculating for the typical section surfacing quantities in Civil 
3D does not exist, so the quantities must be calculated by hand and manually 
entered into the tables. The surfacing calculation spreadsheet on MDT's web 
page is intended to assist designers in calculating the quantities for pavement 
sections. Back to top 
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Procedure – Create Typical Sections 

1. Using the MDT Assemblies located in the State Kit, select the closest 
appropriate assembly for your needs. In this example, MDT Rural 2 Lane was 
used. 

NOTE: Once the basic assembly has been inserted into the drawing, MDT 
Subassemblies (i.e., curb and gutter) can be added or removed to achieve the 
desired typical section. 

 
 

2. When prompted for an insertion point, select a point in the approximate center of 
the top view area. Once the assembly has been placed, press Esc to exit the 
command.  
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3. Select and delete the MDTParameterReferences subassemblies at the center of 
the assembly. 

 

 
4. Select the center handle of the assembly to open the contextual tab in the ribbon 

for assemblies. Select Assembly Properties. You can also right click after 
selecting the handle and select Assembly Properties from the list. 
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5. In the Assembly Properties dialog box, select the Construction tab. Move 
through the Item list and use the Input values section to edit the lane widths 
and material depths to match the surfacing recommendation for the project. 
When finished with an item, select Apply to make the changes.  

NOTE: To change a property from the default value, the Use Parameter 
Reference box must be unchecked. The value will not change on the Input 
values list until the Apply button is selected and the Item is changed. The 
change on the drawing will sync when the Apply button is selected. 

 
 

6. Under the Codes tab of the Assembly Properties dialog box, select the drop-
down menu for Code set style, and select MDT-Typical. Select Apply and OK 
to close the dialog box. 
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7. On the assembly in the model space, select the handles, centerline markers, 
and CL point markers. 

 
 

8. While the items are selected, navigate to the Home tab, and select the drop-
down arrow next to the active layer. Change the layer to X-MISC-NPLT. 

 
 

9. Select Close in the warning box. The handles may still show in the model space 
but should not show in the paper space. The resulting typical should look like the 
image below: 
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10. Use the Blocks Palette to insert the T-Dimensions block and attach it by 
snapping to the crown of the roadway. Insert the T-EndCondition blocks as 
appropriate for the situation. 
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NOTE: The T-EndCondition blocks are set up to connect to the edge of the 
CAC on the inslope, so a line or polyline may need to be drawn to connect the 
rest of the surfacing inslope, like shown in the image below: 

 
 

11. Use the Explode, Copy, and Move tools to label the typical sections to the 
appropriate standards. Snap dimensions to the top surface of the subassemblies 
to ensure that the leader lines are all the same distance from the surface. When 
completed the result should look similar to the image below. 

NOTE: Each item within an exploded block must be individually adjusted and 
moved. If tables or dimensions are exploded down too many levels, each text 
and dimension will have to be individually moved and adjusted. 
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12. For superelevated sections, change the Default Slope input value of each 
subassembly to meet the desired superelevation slope. 

For example, a left curve with a maximum superelevation of 5% would need to 
be changed to -5% on the left side slopes and +5% on the right side slopes. 
Delete the Quantities block and instead insert the T-TableSuperelevation 
block. Snap it to the midpoint of either the horizontal border or the bottom border, 
depending on which panel the superelevated typical is located. 

 
 Back to top  
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Section IV. Summary Frames 

Procedure – Civil 3D File Setup 

1. Create a new file using the design-start.dwt template. Save it as 
[UPN#]RDSUM001.dwg (for example, 9422000RDSUM001.dwg) in the RD 
directory of the project on BIM 360. Use CTRL+S or navigate to the C3D icon in 
the top left and save the file. 
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2. Create a new layout using the Road Layouts within the MDT Sheets tab of the 
MDT Tool Palette. 

 
 

3. Select the RD-Summary layout.  
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4. Delete the default Layout1 from the drawing to clear up space by right clicking 
the layout and selecting Delete. 

 
 

5. Copy Layouts: Copy the RD-Summary layout to create more layout sheets. 
Right click the RD-Summary Layout and select Move or Copy… from the list. 
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6. In the Move or Copy dialog, select (move to end), and check the Create a 

copy box. Then select OK. 

 
 

7. Right click the newly created layouts and select Rename. Rename the layout 
tabs as RDSUM001, RDSUM002, etc. as necessary. 
 

8. Set the active layer to X-MISC-TABL by selecting it from the layer dropdown in 
the Layers panel on the Home tab. 

 
 

9. Type the command OLEFRAME, press Enter, and change the variable to <2> 
by typing 2 then hitting Enter. This allows the frames to display grip handles but 
will not plot the border frame. Changing the value to 1 will plot the border frame. 
 
NOTE: Because this process pertains to a system variable and not a file, it only 
needs to be completed once. It will also need to be completed each time after 
updating the State Kit.  
Back to top  
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Procedure – Excel Quantity Manager File Setup 

1. Create a new Excel Quantity Manager sheet by navigating to the Road Design 
page on the MDT Intranet and selecting the Excel Quantity Manager link under 
the Estimating header and follow the instructions on the page, or by opening 
Microstation and selecting Road Tools > Summary Sheets > Create Excel 
QMG File. 
 

2. Save the file as [UPN#]RDQMG001.xlsx and browse to the RD directory within 
the project through ACCDocs or save the file locally and upload the file to BIM 
360 via the web version.  
 
NOTE: Saving the file to BIM 360 will allow dynamic updates in the summary 
sheets as information is edited in the Excel workbook. 
 
Upload through Autodesk Docs: 

 

 
 
Upload through the web: 

 
 

3. Fill out the summary frames in the Excel workbook to meet the project needs. 
Back to top  
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Procedure – Insert OLE Objects 

1. Within Civil 3D, open the [UPN#]RDSUM001.dwg file created in Step 1 of the 
Civil 3D File Setup procedure if not already open. 
 

2. Select the RDSUM001 layout tab. 
 

3. Open the [UPN#]RDQMG001.xlsx workbook from ACCDocs within the project 
directory on Windows Explorer. 
 
NOTE: Having both files open at the same time will ensure that the two files are 
updated concurrently while working within them. 
 

4. Select a summary frame from the QMG file. Highlight the frame as shown below, 
selecting the cells just outside of the borders of the frame. Copy the data to the 
clipboard using CTRL+C and return to Civil 3D. 

 
 

5. Select Paste Special from the Paste dropdown in the Clipboard panel on the 
Home tab, or type PASTESPEC and press Enter.  
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6. In the Paste Special dialog box, select Paste Link and set the source as 

Microsoft Excel Worksheet (code). Then select OK.  

 
 

7. Select a point in paper space on the RDSUM001 layout tab to paste the linked 
summary frame. 

 
 
NOTE: The OLE will be too large for the summary sheet and must be scaled to 
fit. 
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8. Select the summary frame, right click, and hover over OLE and select Text 

Size….  

 
 

9. Set the text size to OLE 20 = Text Height 0.1440 for the Engineering Heavy 
font.  

 
 
NOTE: The font displayed in the OLE Text Size window is the typically largest 
text size detected in the linked Excel spreadsheet. Updating any font text height 
will update all other font text heights in the OLE. Use the following table for 
converting text heights other than OLE Point Size 20: 

OLE Point Size OLE Text Size 
12 0.0867 
14 0.1011 
16 0.1156 
18 0.1300 
20 0.1444 
22 0.1589 
24 0.1733 



Montana Department of Transportation - Plans Production for Pavement 
Preservation Projects in Autodesk 

 

Summary Frames PAGE 50 | 65 
 

 
10. Repeat Steps 4-9 and paste into the additional layouts as necessary. 

 
11. After the summary frames have been imported and scaled into the layout, 

arrange them by using the Move command under the Modify panel in the Home 
tab, typing MOVE then pressing Enter, or by holding a left click and dragging the 
linked summary frame to its desired location in the paper space. 

 
NOTE: Linked OLEs should update automatically after saving changes in Excel. 
If the OLEs do not update, perform the following steps: 
 
a. Type the command OLELINKS and press Enter.  
b. In the popup box, select all the links using a shift select, or select a specific 

frame that needs to be updated. 
c. Select Update Now. 

 
d. When the update is complete, select Close. 

Back to top 
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Section V. Sheet Set Manager (SSM) 

Procedure – Create a Sheet Set 

1. In the Home Tab select the Palettes drop down menu and open Sheet Set 
Manager or type the command SSM. 

 

 
  

2. In the Sheet Set Manager select the Open… drop down menu and select New 
Sheet Set... This opens the Create Sheet Set wizard. 

 
  



Montana Department of Transportation - Plans Production for Pavement 
Preservation Projects in Autodesk 

 

Sheet Set Manager (SSM) PAGE 52 | 65 
 

3. In the Begin tab of the wizard, select create a sheet set using an example sheet 
set. Then select Next. 
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4. In the Sheet Set Example tab, select the toggle next to Browse to another 
sheet set to use as an example and select MDT_SSM as the sheet set 
example. If it is not already set, select the ellipsis, and navigate to the following 
location:  
C:\mdoh\StateKit\Civil 3D\2022\Templates\Sheets\Sheet Sets. 
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5. In the Sheet Set Details tab, name the sheet set and add a description if 

needed. Use the ellipsis to set the location for the sheet set data file and browse 
to the BIM 360 project RD - Road Design folder. 

 
 



Montana Department of Transportation - Plans Production for Pavement 
Preservation Projects in Autodesk 

 

Sheet Set Manager (SSM) PAGE 55 | 65 
 

 
 

6. In the Confirm tab, verify that the settings are correct and click Finish to create 
the Sheet Set. 

 
Back to top  
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Procedure – Create a Subset 

1. Right click on the Sheet Set in the Sheet Set Manager and select New 
Subset... 

 
 

2. Set the Subset name as ROAD PLANS and select OK to create the Subset. 

 
Back to top 
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Procedure – Add Sheets to the SSM 

1. Right click on the Subset in the Sheet Set Manager and select Import Layout 
as Sheet… 
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2. In the Import Layouts as Sheets dialog box, select Browse for Drawings…. 
Navigate to the location of the project drawings. Using shift or control, select all 
the drawings containing the desired layouts for plotting and select Open. 

 
3. Use the checkboxes to select the layouts necessary for plans. Then select 

Import Checked. 
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4. Once the layouts are imported, the sheet order and numbers can be changed by 
right clicking on the sheet and selecting Rename & Renumber… 

 
 

5. In the Rename & Renumber Sheet dialog box, rename and renumber the 
sheets as desired. Toggle through sheets by selecting the Next > button. 

 
NOTE: The process of renaming and renumbering the sheet will automatically 
populate sheet numbers on the layouts as seen below. These numbers will 
automatically update if a sheet is moved within the sheet set. 

 
Back to top 
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Procedure – Edit Project Information in the SSM 

1. To edit project information, right click on the sheet set in the Sheet Set Manager 
and select Properties….  
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2. Fill in project information by double clicking into fields to edit. 

 
 

3. Once all the appropriate project information has been entered, select OK to close 
the dialog box. This will auto-populate information on the blocks of every sheet 
including the project name, county, project ID, UPN, and work group. It will also 
update the title on the title sheet.
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NOTE: It is important that you do not edit or delete the fields underneath the 
Project Control or Sheet Set Custom Properties within the borders, as the 
fields are tied to the Sheet Set Manager. If the fields no longer have a box 
around them, the association has been lost and the border block will need to be 
replaced with the standard border block in the layout to bring the associated 
fields back. 
Back to top 

  



Montana Department of Transportation - Plans Production for Pavement 
Preservation Projects in Autodesk 

 

Sheet Set Manager (SSM) PAGE 63 | 65 
 

Procedure – Edit Other Sheet Information 

1. Each sheet will have information that will need to be hand-edited. This includes 
the Checked by, Reviewed by, Designed by name and date attributes, and the 
sheet description attribute. To edit these, double click on the place holders 
(######). This will open the Enhanced Attribute Editor dialog box. 

 
 

2. Select the desired tag or prompt and fill in the value with the desired content. 
Select Apply and the attribute in the drawing will populate. Once completed 
select OK. 
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3. To edit the sheet description, double click on the attribute. This will open the 
same dialog box as before. Because this attribute has multiple text lines, select 
the button next to the value box to open the Multiline Editor. 

 
 

4. This will open a Text Formatting box. Make the changes to the sheet description 
and select OK. Then select OK in the Enhance Attribute Editor dialog box.  

 
Back to top  
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Section VI. Plot Sheet Sets 

Procedure – Plot a Sheet Set 

1. To publish a PDF of a plan sheet or entire subset, right click on the item in the 
Sheet Set Manager and select Publish to PDF. 

 
2. Select where the PDF will be saved and select Print. A processing window will 

appear to display progress. Once the print job is complete, the following message 
will display on the lower bar of Civil 3D.  

 
Back to top 
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